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1 Introduction 
MK Design Indexer 2.0 is the upgrade from QPI 1.5.  Quilt Pattern Indexer is now MK Design 
Indexer.  We have added embroidery support and general bug fixes.  General functionality 
has not changed. 

MKDI is a powerful tool.  It has been kept as simple to use as possible, but there are now 
advanced features that may take a little time to learn.  Many features in the program have a 
new HELP button that will bring you to this manual. 

The terms "patterns" and "designs" are used interchangeably in this document. 

No patterns are included in the program.  MKDI simply reads the pattern files that exist 
in designated folders.  The program will help you set up which folders are scanned and 
indexed. 

Please review this manual before contacting support. 

Note: If this document is being used electronically, all cross-references and section 
references are hyperlinks.  Just point your cursor at the reference.  The cursor 
should turn into a finger pointer.  A click will take you to the referenced location in 
the document. 

If you use Facebook, join the MKDI Community public group and use the search feature 
prior to posting your questions there.  It is likely that someone has asked the question 
before. 

If you do not use Facebook or cannot find the answer there, use this website to schedule a 
live support call:  https://www.mkquilts.com/support.html 

Click here to be taken to the MKDI Facebook group. 

2 Installation 

2.1 Installation and Running for the First Time 
Download the program.  Go to mkdesignindexer.com, select Download, then follow the link 
to download the program. 

After running the .exe file that was downloaded, you should end up with a MKDI icon on 
your desktop.  As with any other program, simply double-click/double-tap the icon to run 
the program.  If you are not currently licensed to use the program, the "About" window will 
display.  There is a 14 day trial period from when you first install MKDI. 

MKDI can also run on the Pro-Stitcher tablet.  Just use a USB memory stick to take both the 
program and activation key to the device.  The Keyword - Sync... feature can be used to 
quickly keep a laptop and the Pro-Stitcher tablet synchronized.  (See section 8.2.3 for more 
information.) 

https://www.mkquilts.com/support.html
https://www.facebook.com/groups/174456639928017
https://www.mkdesignindexer.com/
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2.2 Finding the patterns 
No patterns are included in the MKDI program.  MKDI simply reads the pattern files that 
exist in designated folders.  By default, the program will scan and index pattern files found 
in C:\Designs on the local hard drive.  This is the default storage location for the free Handi 
Quilter patterns. 

It will also look for a "Designs" folder in your "Documents" folder 
(C:\users\<yourname>\Documents\Designs).  This location was proposed in previous 
versions as a place to store purchased patterns, however the new "Purchased Folder" 
feature and related ZIP extraction feature make this obsolete.  (See sections 8.1.1 and 8.1.2 
for more information.) 

You may add and delete folders to be searched by the MKDI program by selecting File -
Settings through the main menu.  (See section 8.1.7.1 for more information.) 

Encrypted patterns cannot be managed by MKDI.  Encrypted patterns normally have a 
file extension ending with the letter "x".  When buying patterns, all patterns should be 
uncompressed (unzipped) as directed by the designer.  Unsupported file extensions will 
simply be ignored by MKDI.  Ask the designer to contact MK Quilts about future support of 
their encrypted patterns. 

2.3 Upgrading from a Previous Version 
Follow the same steps described in section 2.1.  MKDI should use all of your previous 
settings, including your license.  If MKDI does not recognize your license, select "Activate 
Now" and choose your license file. 

2.4 License Activation and Free Trial Period 
The program will run for 14 days from the initial installation without purchasing a license.  
If updating from QPI 1.5, you will be able to use the Embroidery features for 14 days.  
Purchasing the MKDI program or license can be done at shop.mkquilts.com.  We sell 
versions of MKDI pre-licensed as well as the individual quilting or embroidery license key.  
If you upgraded QPI to MKDI, you already have the quilting license.  You may buy the 
embroidery license only and add it to your existing program. 

The "Activator" licensing program used with QPI 1.5 is no longer used.  If you have issues, 
email mkdi-support@mkquilts.com. 

3 The MKDI program window 
The MKDI window has a standard two pane layout common to many programs.  The left 
side has a familiar folder tree layout with top level folders for these major categories:  

• Favorites 
• Pattern Folders 
• Keywords 
• Recent Searches 

https://shop.mkquilts.com/search.php?search_query=mkdi
mailto:mkdi-support@mkquilts.com
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Figure 1:  The MKDI Program Window 

The right side will contain thumbnails of patterns.  This may be filtered by the selection in 
the left pane or a keyword search parameter entered at the top of the window. 

MKDI implements advanced pattern management features.  You can find and delete 
duplicate patterns from File - Find Duplicate Files (see section 8.1.4) and move patterns 
and folders within the managed folders (see section 4.2.2).  Also, the "Open in Explorer" 
feature has been added to most context menus in case you need to do something restricted 
in MKDI.  MKDI still attempts to protect the novice user from making mistakes, so use these 
features with caution. 

4 Basic Controls 

4.1 Selection and Search Tips 
There are two main sections of the MKDI main program window, the left pane and the right 
pane.  The left pane has a pseudo tree layout while the right pane will have a grid of 
thumbnail images.  What you have selected on the left will not only affect what is displayed 
on the right, but it will also determine the starting point of the search that is performed 
from the top search input line. 

Without a search, the right pane will display only patterns in that folder, but not the sub-
folders.  Therefore, selecting a folder that does not have any designs in it will display 
nothing except a statement that no patterns are found in the folder. 
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A search will look through the folder selected in the left tree pane, including all the sub-
folders.  It also now lists the search in the left pane "Recent Searches" tree listing (at the 
bottom of the window), showing the search criteria, including the starting folder of the 
search.  You may re-select any previous search results, however MKDI does not actually re-
run the search unless you right-click (or touch-and-hold on touch screens) on the search 
and select "Repeat Search". 

Hint: To find patterns that have no keywords assigned to them, put two double quotes 
("") in the search field. 

Max thumbnails per row can be selected with the slider in the lower right corner of the 
main window.  This will allow you to scale the thumbnails to your personal preference, 
given your screen size and resolution. 

4.2 Navigation 

4.2.1 Single click/tap 
In the left tree pane, a single click or finger tap will select a folder item. 

In the right pane, in order to avoid the issues people can have with double clicking/tapping, 
we have made the single tap open the preview window instead of selecting the file.  
Multiple preview windows can be opened at the same time.  We also implemented a 
"Select" button at the top right that will toggle the single click/tap mode between "Open" 
and "Multi-select".  If you select multiple items, right-click (or touch-and-hold on touch 
screens) to bring up the thumbnail menu (see section 4.2.2.2). 

4.2.2 Context Dependent Menus 
Clicking the right mouse button (or touch-and-hold on touch screens) will bring up a 
context-dependent menu.  This means the menu that is brought up will depend on what is 
under the cursor when you click on it. 

There are three specific context dependent menus:  the tree menu, the thumbnail menu, 
and the preview menu. 

4.2.2.1 The Tree Menu 

When you right-click (or touch-and-hold) on a folder in the left pane, you will get the tree 
menu (see Figure 2).  Any selection you make from this menu will affect the folder and all of 
its contents. 
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Figure 2:  Tree Menu 

4.2.2.2 The Thumbnail Menu 

When you right-click (or touch-and-hold) on a thumbnail image or selected group of images 
in the right pane, you will get the thumbnail menu (see Figure 3).  Most of the selections 
from this menu will affect all files selected, but some (such as "File Information" and 
"Rename...") only affect the file whose image is under your pointer when you bring up the 
menu. 

 
Figure 3:  Thumbnail Menu 

If you bring up preview windows of multiple files, but you don't see them all, try moving the 
preview window you see to another location on the screen.  MKDI usually puts the windows 
on top of each other. 

If thumbnails have poor quality, try the "Regenerate Thumbnail" option, which can be done 
at both the file and folder level. 

4.2.2.3 The Preview Menu 

When you right-click (or touch-and-hold) in a preview window, you will get the preview 
menu (see Figure 4).  The selections from this menu will affect only the file currently shown 
in the preview window. 
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Figure 4:  Preview Menu (from embroidery file) 

4.2.2.4 Tool Tips 

Tool Tips are the box of information that appears when hovering the cursor (not clicking) 
over many objects throughout the program.  In most cases, the tool tips provide 
information such as file name, file or folder location, and keywords. 

4.2.2.5 Preview Windows 

You may open one or more preview windows from various folders.  The context sensitive 
right-click (or touch-and-hold) menu described above provides additional features. 
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Figure 5:  Example of Multiple Preview Windows 

You may move and resize the windows to compare several patterns in more detail.  The 
"Copy File to..." option can be used to efficiently copy that pattern to a USB drive and/or 
customer specific folder. 

Keywords can be added or modified by using the input line at the bottom of the window.  
See section 6 for more information about assigning and managing the keywords. 

If a specific pattern does not appear to render properly, please feel free to copy the file to a 
folder, zip/compress it, and email it to mkdi-support@mkquilts.com. 

5 The Importance of a File Management Plan 
Many longarmers and embroiderers are not experienced computer users and are just 
looking for a basic understanding of how to manage the patterns that they have purchased.  
MKDI has implemented a standard process and features to help the user unpack and 
manage their purchased patterns.  Note: This is not the only way to manage your design 
files. 

Handi Quilter puts the included patterns that come with Pro-Stitcher in a folder on your 
computer or tablet called C:\Designs.  ("C:" is the device name - your internal storage in this 
case.  "Designs" is the folder name.) 

 

mailto:mkdi-support@mkquilts.com
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A user's files are normally stored in what they call your "home" folder.  This folder is called 
C:\users\<your name>.  There are sub-folders called Documents, Pictures, Videos, Music, 
and Downloads in your home folder.  And then the Windows folks proceed to confuse 
everyone by hiding the fact that the home folder even exists by making the File Manager 
display these folders under an item in the left tree window called "This PC".  It is enough to 
confuse anyone! 

In our opinion, had Pro-Stitcher been programmed as a Windows program from the start 
and not a controller for your machine, Pro-Stitcher would not have stored the included 
patterns differently.  So do not feel bad about your confusion.  Your phones, tablets, and 
Macintosh/Apple computers hide all this file system stuff from you by default.  When you 
purchase designs, you should try to keep them in your Documents folder as this is normally 
backed up by various utilities. 

MKDI can help you set up a "#Purchased_Patterns" folder to help with your file 
management.  See section 8.1.1 for details. 

If you have a mess and want to start over with the default C:\Designs structure and safely 
keep a copy of what you have now, MKDI can help with that also.  See section 8.1.6 for 
details. 

6 Keywords 

6.1 General Information 
Keyword information is stored in the user's hidden data folders.  In order to backup, share, 
or simply copy the information to another computer, you must export the information to a 
file.  The extension on the file is ".qpi.json".  (Yes, we should have changed it, but we didn't.) 

Importing a "*.qpi.json" file will add the keyword information from that file to your 
computer, even if the pattern is not available on that computer.  If and when the pattern is 
installed in a folder that MKDI is configured to watch, it will apply the keywords. 

6.2 Managing Keywords 
The "Keywords" category in the left pane can be used to review all your keywords.  If you 
select a keyword, MKDI will display all patterns tagged with that keyword.  

When you open any preview window for a pattern, you will see a space-separated list of 
keywords (if any) for that one pattern. 

You may also use the "Select" button at the top right of the main window to toggle to multi-
select mode and select multiple patterns.  When you have more than one pattern selected, 
you can right-click (or touch-and-hold), then choose "Manage Keywords".  You can see what 
keywords are assigned to the selected patterns, and you can use the left side of the dialog 
window to add and remove keywords to all the selected patterns (see Figure 6). 

Note:  A check means that the keyword is assigned to all of the selected patterns.  A black 
square means that the keyword is assigned to some, but not all, of the selected patterns. 
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Figure 6:  Keyword Management Example 

Managing keywords across thousands of designs is challenging.  The search function will 
search the file names as well as keywords, so MKDI will provide helpful functionality even 
without keywords. 

6.3 Understanding a Hash Value Versus a File Name 
The operation of the MKDI program may make more sense to you if you understand that 
MKDI is ignoring the file name and assigning the keywords and notes to the "hash value".  
What is a "hash value"?  It is simply a large number that is created based on the contents of 
the file.  Meaning, even if you copy and rename a pattern file, the MKDI program will look at 
it and see it as the same file because the content is the same.  This also prevents two 
different patterns called "Small Block.hqf" from being mistaken for the same file. 

If you add a single pattern to your Favorites, you may see more than one copy of the pattern 
in the thumbnail view.  If you hover the cursor over them, the Tool Tips dialog box will 
show you that they are duplicate files saved in different directories. 

7 Printing 
MKDI allows you to print single patterns, multiple patterns, or the contents of an entire 
folder.  Select the pattern, patterns, or folder that you want to print, then right-click (or 
touch-and-hold), and select "Print".  You need to select "Print" in the Print dialog box 
(Figure 7), then you will be given a Preview Window (Figure 8).  You have the options of 
printing full path names, keywords, and notes beneath the patterns. 
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Figure 7:  Print Dialog Box 

 
Figure 8:  Print Preview Window 
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8 The Menus 

8.1 File Menu 

 
Figure 9:  File Menu 

8.1.1 Create Purchased Folder 
MKDI provides a feature to help you better manage your purchased patterns, separate from 
the default C:\Designs folder used by Pro-Stitcher.  MKDI will create a folder called 
#Purchased_Patterns in your home Documents folder.  A link is then created in the 
C:\Designs folder so it will look like the #Purchased_Patterns folder is there.  

 
Figure 10:  Purchased Patterns Folder Example 

You should only need to create the purchased folder and related link once unless you 
accidentally delete it.  (Deleting the link does not delete the target folder with the patterns 
in it.)  If the link is accidentally deleted, you can use the "Create Purchased Folder" option to 
recreate it. 

The "Open Pattern Zip..." process described below will utilize this #Purchased_Patterns 
folder when extracting patterns from a compressed/zipped folder. 
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8.1.2 Open Pattern Zip... 
MKDI provides this feature to allow a user to open a compressed (zip) folder/file and 
extract only a single copy of a pattern/design.  Many designers provide multiple formats of 
the same pattern in the purchased pattern package.  Based on the priority you set in 
Settings (see section 8.1.7), the "Open Pattern Zip..." utility will select that format and then 
save the patterns into the #Purchased_Patterns folder.  MKDI will extract all the patterns it 
finds at once, preserving any sub-folder structure. 

 
Figure 11:  Open Pattern Zip Example 

Most designs will have a folder already named, so you can leave the "Include archive 
filename" unchecked.  In this example, the "Designs By Vickie" folder will be extracted into 
the #Purchased_Patterns folder.  Remember that this folder will also appear at the 
C:\Designs\#Purchased_Patterns path due to the link put in place. 

The folder structure from the compressed zip will be recreated within the 
#Purchased_Patterns folder.  But only one version (format) of a specific pattern name will 
be saved into these directories.  That format will be chosen based on the order you have the 
pattern formats listed in the Settings dialog.  This will avoid duplicates. 

Select File - Refresh Tree if your new files do not appear.  Most actions should trigger a 
refresh, however manually refreshing the tree is a good way to resolve issues, especially if 
you have been using the external File Manager to move things around. 

Note that if you right-click (or touch-and-hold), you can bring up a context-dependent 
menu that will allow you to rename and move a folder. 
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8.1.3 Search for Notes 
The "Search in Notes" item under the File menu allows you to search any text that you 
added to a pattern using the "Edit Notes" context-dependent menu.  Figure 12 shows the 
results of a search for the string "paul".  Four items resulted from the search.  To be able to 
see these results after you close this search window, select the "Save Search Results" button 
before closing the window.  The search will be added to bottom of the tree listing in the left 
pane of the main MKDI window. 

 
Figure 12:  Search for Notes Example 

If you right-click (or touch-and-hold) on a pattern, either the thumbnail or in a preview 
window, you can choose "Edit Notes" (see Figure 13).  The "Edit Notes" feature allows you a 
place to make notes that are not included in the default searches (see Figure 14).  You can 
only add and modify notes on one pattern at a time.  The note information is not written to 
the pattern file, but will be included as part of the keyword information. 
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Figure 13:  Contextual Menu to get to Edit Notes 

 
Figure 14:  Edit Notes Example 

8.1.4 Find Duplicate Files 
There are many reasons to have duplicate files.  MKDI can show you duplicate files based on 
the contents, not just the name.  Even if two designs are named "corner borders" by two 
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different designers, they may not truly be the same file.  A hash value is created from the 
contents of each file to make sure they are really the same. 

Selecting File - Find Duplicate Files will open a Duplicate Patterns dialog box.  Selecting 
any design in the left pane will show you the locations of every copy of that file (see Figure 
15 for an example). 

 
Figure 15:  Duplicate Files Example 

The Duplicate Patterns dialog box will show you the duplicate files and allow you to select a 
file.  Once a file is selected, you can select "Open in File Explorer" to see and manually delete 
the file if desired, or you can select "Delete File" to let MKDI remove the file for you 
permanently.  If you select "Delete File", you will be prompted for a confirmation. 

The clock thumbnail you might see in the left pane is used when the real thumbnail has not 
yet been created.  The thumbnail is typically created the first time a design is viewed in the 
program, so its creation does not slow things down.  A future release will work in the 
background to resolve this issue sooner. 

8.1.5 Backup Patterns... 
Selecting File - Backup Patterns... will copy all patterns to a folder entitled "Patterns 
Backup (<date>)".  You may choose where this backup folder is saved (see Figure 16).  We 
recommend saving it to a USB drive or a network drive, to protect from a hardware failure 
of your computer.  The current keyword information is also exported to a 
"keywords.qpi.json" file within the backup folder. 
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Figure 16:  Backup Patterns Window Example 

Restoring the backup is a manual process.  The backup folder has all the pattern folders, 
and they can be copied to any computer using File Manager.  The "keywords.qpi.json" file 
can be imported into MKDI to restore the keywords. 

This backup feature is not intended to be used for copying the patterns for sharing or any 
other illegal purposes.  It is recommended, however, that you keep an offline copy for 
recovery or migration to a new computer. 

8.1.6 Reset Designs Folder 
If you are following the #Purchased_Patterns process described in section 8.1.1, you should 
not be storing anything but the default Handi Quilter patterns in C:\Designs.  The "Reset 
Designs Folder" feature in the File menu allows you to move the existing C:\Designs folder 
to "C:\Designs before QPI reset", then it recreates the C:\Designs folder so that installing 
the Pro-Stitcher software will also install the default patterns.  (We recommend using Pro-
Stitcher version 516 or later, as Pro-Stitcher changed folder names and corrected issues 
with pattern thumbnails - sort of.)  You will need to manually download the Pro-Stitcher 
software and install it. 

After resetting your designs folder, you should then manually review the old designs folder 
and move any non-standard folders to the "C:\Designs\#Purchased_Patterns" folder.  You 
will probably need to select "Refresh Tree" (see section 8.1.88.1.7.6) when you are done. 
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8.1.7 Settings 
When you select File - Settings, MKDI opens the window shown in Figure 17.  From this 
window, you will be allowed to modify important parameters of the MKDI program. 

 
Figure 17:  Settings Window 

8.1.7.1 Indexed Folders 

Indexed (searched) folders can be added or deleted from the list to control where the MKDI 
program looks for patterns.  All sub-folders are searched, so make sure you only select the 
folders you need.  Selecting the root "C:\" folder will cause the searching of the entire 
computer every time the program is started.  This will take time and is not recommended. 

Any links created in these folders, including those created by Pro-Stitcher Designer, will be 
indexed by MKDI.  You may safely remove/delete a link without deleting the target folder. 

Removing a folder from this list does not remove the keyword information from the QPI 
program.  If you add the folder back later, the keyword information will be restored as well. 

8.1.7.2 Openable Formats 

The list of formats shown will vary, depending on whether your version of MKDI is licensed 
for quilting, embroidery, or both. 

The list of file formats can be sorted.  This sorted list is used by the "Open Pattern Zip..." 
utility (see section 8.1.2) to save only a single version of a pattern from the compressed 
(zip) file.  To change the order of the formats, select a format, then use the "Up" or "Down" 
button to change its place in the order.  In the situation shown in Figure 17, the .hqf format 
of a pattern would be saved.  If the .hqf did not exist, the .hqv would be saved, and so on.  If 
you like to use .qli as your primary format, move that to the top. 
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8.1.7.3 Expand folder on selection 

The folder tree in the left pane will automatically expand when you select it, assuming there 
are sub-folders.  This can be disabled if you wish. 

8.1.7.4 Delete trash Files (._*) 

One common problem is that users can copy system files from a Macintosh computer via a 
USB memory stick along with the patterns they downloaded while on their Mac.  These files 
start with "._" and have a valid extension on the end.  To avoid having them show up as 
broken patterns, MKDI can automatically delete them in the managed folders.  This feature 
can be disabled if you want to delete the files yourself. 

8.1.7.5 Show format overlays 

The thumbnails now have a small overlay in the lower right side of the image, identifying 
what format the pattern is (see Figure 18).  This overlay can be toggled off. 

 
Figure 18:  Format Overlays 

8.1.7.6 Keyword By Name 

This feature is not supported at this time. 

8.1.8 Refresh Tree 
MKDI monitors folders that existed when the program was started.  If new folders are 
added while the program is running, it may be necessary to use the File - Refresh Tree to 
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get the new folders to show up in the program.  Restarting the program will also 
automatically refresh the tree. 

8.1.9 Exit 
Selecting File - Exit will cause the MKDI program to quit.  Another way to exit the program 
is to select the "X" in the upper right corner of the window. 

8.2 Keywords Menu 

 
Figure 19:  Keywords Menu 

Many keyword-related options are now in their own "Keywords" menu.  Many of the 
features for keywording are accessed through the context-dependent (right-click) menus 
that appear for files and folders.  See section 6.2 for more information on the mechanics of 
keywording. 

MKDI includes a set of default keywords provided by MK.  Applying additional keyword 
files will not delete previous keywords.  It will add keywords only. 

Keyword information is stored in the user's hidden data folders.  In order to backup, share, 
or simply copy the information to another computer, you must export the information to a 
file.  The extension on the file will be ".qpi.json".  (Yes, we should have changed it, but we 
didn't.) 

Importing a "*.qpi.json" file will add the keyword information to a computer, even if the 
pattern is not available on that computer.  If and when the pattern is installed in a folder 
that the MKDI program is configured to watch, it will apply the keywords. 

No patterns are copied or moved by the Import or Export options. 

8.2.1 Import... 
Selecting Keywords - Import... allows you to import a keywords file from an external 
source.  Just navigate to the location of the file, select the keywords file, then select "Open".  

8.2.2 Export... 
To create a copy of your keywords file, select Keywords - Export..., navigate to the location 
where you want to save the new file, enter the desired file name, then select "Save".  This 
file can be shared, copied to another computer, or simply kept as a backup of your 
keywords. 
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8.2.3 Sync... 
The Sync feature is a quick method for exporting the keywords in such a way that you can 
synchronize the keywords on two different devices.  The Sync feature requires that a USB 
memory stick be attached. 

This feature is a quick way to keep the keywords on your machine tablet in sync with those 
on your personal computer where you are running Pro-Stitcher Simulation.  If your 
embroidery machine is running Windows, you may be able to also run MKDI on your 
embroidery machine. 

To use the Sync feature, select Keywords - Sync..., then select the USB drive in the left part 
of the window.  The window will show you if there is a sync and/or a backup file with 
keyword information, as well as their dates.  If you don't see your USB drive, or if you insert 
a different USB drive, select "Refresh List" to update the window. 

Note that no designs are copied by any of the Sync actions.  Only the keyword and hash 
information are copied.  The target MKDI system does not need to have the actual design 
files.  The new information will be copied, but it will not be used if the referenced design 
file is not present.  If the design file is added later, MKDI will already have the keyword 
information available. 

 
Figure 20:  Synchronize Keywords Window 

8.2.3.1 Create Backup 

"Create Backup" will write a copy of the keyword file, as it exists at that point in time.  The 
file name of the backup file contains the date of the backup, so only one backup file can be 
saved per day. 

8.2.3.2 Sync To 

"Sync To" will cause any new hash or keyword information from your active MKDI index to 
be copied to the USB sync file. 



 

User Manual 
MKDI Version 2.09 

 

User Manual Rev - © 2023 by MK Quilts.  All rights reserved. 21 

8.2.3.3 Sync From 

"Sync From" will cause any new hash or keyword information from to be copied from the 
USB sync file to your active MKDI index. 

8.2.4 Reset 
Select Keywords - Reset to delete all your keywords.  Use this function with caution unless 
you have recently made a backup of your keywords. 

8.2.5 Restore Defaults 
Select Keywords - Restore Defaults to restore the MK keywords. 

8.3 Help Menu 

8.3.1 MKDI Facebook Group 
Selecting Help - MKDI Facebook Group will open your browser and take you to the MKDI 
group in Facebook. 

8.3.2 Support Website 
Selecting Help - Support Website will open your browser and take you to the 
Support/Manual page of the MKDI website. 

8.3.3 MK Quilts University 
Selecting Help - MK Quilts University will open your browser and take you to the MK 
Quilts University website. 

8.3.4 What's new 
Selecting Help - What's new will open your browser and take you to the "What's New" part 
of the Support/Manual page of the MKDI website. 

8.3.5 About 
Selecting Help - About will show you a window with the MKDI version number, as well as 
your licensing status. 

9 FAQ - Frequently Asked Questions 

9.1 Synonyms 
These words are often used interchangeably: 

• Folder - Directory 
• Pattern - Design 
• Melissa - MK 

9.2 I can't see any designs in the QPI window 
By default, MKDI looks for designs in C:\Designs.  It will also look for a "Designs" folder in 
your "Documents" folder (C:\users\<yourname>\Documents\Designs) if it exists.  By 
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default, Pro-Stitcher loads free designs into the C:\Designs folder on the Pro-Stitcher tablet 
at the machine, but these designs need to be copied to the computer running the simulator 
software. 

You can add and delete folders to be searched by the MKDI program by selecting File -
Settings through the main menu.  (See section 8.1.7.1 for more information.) 

9.3 What is the best place to save my patterns? 
For the computer novice, we have integrated a standard practice into MKDI that will create 
a "link folder" under C:\Designs called "#Purchased_Patterns".  The "#" symbol will make it 
appear at the top of a listing for easy access.  MKDI will also create an actual folder in your 
Documents folder of the same name.  All patterns stored here will appear that they are 
under the C:\Designs folder, but they actually are stored properly under your Documents 
folder. 

Wherever you store your patterns, be sure that they are securely backed up somewhere 
other than your computer or Pro-Stitcher tablet. 

9.4 My C:\Designs folder is a mess!  What can I do? 
MKDI provides a feature to move your existing C:\Designs folder aside and walks you 
through installing the latest fresh copy of the patterns that come with Pro-Stitcher.  You will 
then need to manually go through the original folder and move any patterns you want to 
retain into your #Purchased_Patterns folder.  See section 8.1.6 for more information. 

9.5 Can I install MKDI on multiple computers? 
Yes, one user may activate multiple copies of MKDI on different computers.  Simply 
download another copy of the Activator using the download link in the email sent to you 
when you purchased it.  If you need assistance in setting it up, however, there may be a 
service charge. 

9.6 Some of my designs are not showing up 
The program supports the file formats shown in "Settings" (see section 8.1.7).  The list of 
available file formats will be different depending on whether your version of MKDI is 
licensed for quilting, embroidery, or both.  Make sure that the designs you are attempting to 
view are in one of the supported file formats. 

It is possible that you have not yet uncompressed/unzipped the files that you purchased.  
Be sure to uncompress/upzip the files into a folder that is being indexed by MKDI (see 
section 8.1.7.1).  Select File - Refresh Tree or restart the program to ensure that the new 
files are found. 

9.7 How do I update to the latest version? 
Simply download the MKDI software from the Download page 
(www.mkdesignindexer.com/download.html) and install it as you installed the software the 
first time.  The new software will simply overwrite the previous version.  Your settings and 
keywords are stored separately and will not be changed. 

https://www.mkdesignindexer.com/download.html
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9.8 What is a "dot release"? 
When you purchase the QPI program, you will be entitled to use the program as long as you 
have a machine that will run the program.  For the sake of this discussion, we are talking 
Windows 7 and Windows 10 systems. 

You are also entitled to any "dot releases".  These are usually bug fixes and minor 
enhancements needed to keep the program running well.  The "dot" signifies the decimal in 
the program version number.  If you buy version 1.0... you are entitled to version 1.0, 1.05, 
1.1, 1.2, 1.3, 1.35, etc.   

Our goal for software tools is to keep them simple and focused on our customer.  Features 
that add complexity and address other audiences will likely be kept as a separate product.  
This will keep the cost of the tools reasonable so you have more money for quilting. 

10 Troubleshooting Steps 
If you are having problems with MKDI, here are some things that you can step through to 
get it working. 

1. Install the software.  For version 1.5 and earlier, the activation program only installs 
the license, but you must also install the software. 

2. After 14 days, the software will not go past the title box.  Purchase a license from 
shop.mkquilts.com/search.php?search_query=mkdi 

3. Make sure you have your patterns installed on your computer.  If you do not have 
them under the C:\Designs folder or the "Designs" folder in your "Documents" folder 
(C:\users\<yourname>\Documents\Designs), you need to add the top-level path to 
the list of Indexed Folders (see section 8.1.7.1) so that it will look for your patterns 
there. 

4. Read this manual, which is available via the Help menu or directly at 
www.mkdesignindexer.com/support.html 

5. Book a time for us to get on your computer with you to fix any issues.  It will 
normally take us less than 15 minutes to do so, and you will not be charged because 
you are an MKDI owner.  Go to:  www.mkquilts.com/support.html 

11 Release Notes 

11.1 MKDI Version 2.09 
• Addressed a lot of confusion with the window that pops up when a trial license is 

active.  We still don't have an OK button, so just hit the 'X" to close the window.  QPI 
= Quilting license is still active even if the trial Embroidery license period is running.  
The Activate Now button was not available during a trial. 

• Added a Keyword by Name feature... still in testing.  This may help when Handi 
Quilter changes their default patterns between versions.  It should allow you to 
bring over the keywords from the previous version if named the same. 

https://shop.mkquilts.com/search.php?search_query=mkdi
https://www.mkdesignindexer.com/support.html
https://www.mkquilts.com/support.html
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• Thumbnails are regenerated automatically as needed. 

• Online manual updates will take a week or so to update. 

• The color blocks on the preview window no longer shows for single color patterns 
like quilting patterns.  Saving screen space. 

• Known issue:  Help buttons throughout the program, as well as the "Support 
Website" and "What's new" options from the Help menu, all point to the old 
quiltpatternindexer.com website. 

11.2 MKDI Version 2.05 
• MK Quilts-Clone Keywords feature removed. (did not work) 

• Changed the term "Purchase" to "Purchased". 

• Removed the next line that states "No Licenses detected. Running in trial mode 
only". 

• Activate Now dialog defaults to the user's Downloads folder. 

11.3 MKDI Version 2.04 
• Scaling issues corrected. 

• New feature:  Adjust number of thumbnails displayed. 

• Increased thumbnail image size/detail - Need to refresh folder manually for now. 

New features: 

• Embroidery Design Support 
• Many bug fixes 
• Renaming of the program 
• Simplified licensing mechanism - pre-licensed downloads 
• Faster processing 
• Control the number of thumbnails displayed in a row 
• Color count listing in preview 
• Scaling improvements 

11.4 QPI Version 1.5 (August 2020) 
Free update to current owners of Quilt Pattern Indexer - QPI. 

New Features: 

• SEARCH for patterns WITHOUT KEYWORDS by using two double quotes - "" - as the 
search input.  Like other search functions, it will search from the selected folder 
through sub-folders.  You can right-click on the search tree item to 'manage 
keywords' and to 'refresh search' as you apply keywords.  

• Established process for managing purchased patterns.  CREATE PURCHASED 
FOLDER menu item creates a folder - #Purchased_Patterns - in your personal 
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Documents folder AND it creates a link in the C:\Designs folder so that it appears in 
that folder too.   

• OPEN PATTERN ZIP menu item that will provide a custom interface for extracting 
purchased patterns into your "#Purchased_Patterns" folder.  It will extract only one 
copy of the pattern based on the priority you provide for QLI/HQV/HQF formats, 
reducing the likelihood of duplicates. 

• EXPAND FOLDER ON SELECTION settings option.  (On by default.)  This will cause 
the left tree to expand when selecting a folder that has sub-folders.  You no longer 
have to click the "+" symbol to expand the tree. 

• FIND DUPLICATE PATTERNS - Displays a thumbnail of pattern in left tree.  DELETE 
FILE button available to delete selected file from list.  A warning dialog asks for 
confirmation. 

CAUTION: The ability to DELETE has been added to QPI 1.5.  Previously we limited 
file management functions that could lead to the loss of a pattern.  A warning 
prompt is given to confirm any deletion. 

• THUMBNAIL MODIFICATION FEATURES - "Regenerate Thumbnails" has been added 
to the folder context dependent menu.  This will resolve most thumbnail issues. 

Due to some of the embedded thumbnail images in patterns that are not rotated 
appropriately, we now allow you to rotate and flip the thumbnails - without actually 
modifying the patterns.  Right-click on the thumbnail(s) will allow you to "Flip 
Thumbnail Vertically" which will generally correct the issue.  (Select all in a folder 
and do them at once.)  If you are in preview mode, a right-click will allow you to 
rotate and flip the image.  Upon closing the preview, you will be prompted whether 
you want to save that change to the thumbnail. 

• PRINT SETTINGS dialog appears after hitting the print button to allow you to see a 
small preview and select options: Print full paths, Print Keywords, Print Notes. 

• MOVE TO... context menu item added to allow you to move a pattern or folder - BUT 
ONLY WITHIN THE MANAGED TREE.  IF you want to move it to a folder or USB 
location, use the COPY TO... context menu item.  This is done to avoid confusion due 
to the patterns disappearing from QPI if you move them to a folder outside of the 
QPI Indexing path (configured in the settings dialog.) 

• OPEN IN EXPLORER context menu item added to automatically open the File 
Explorer to that file/folder.  If you rename through the File Explorer, you need to 
select FILE->REFRESH TREE for QPI to see the change. 

• KEYWORDS management broken out to its own menu tree.  Import and Export 
Keywords options have not changed.  The new SYNC option will either export or 
import keywords from a USB.  This is to simplify keeping two devices in sync. 

Backup vs. Sync:  Sync just deals with the keywords.  You can use the Backup 
Patterns option to go to USB and then manually restore those pattern files to 
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another device if you need to make sure the patterns are the same on both devices.  
The keyword file is also exported and can be manually imported on the new device.  

• DEFAULT KEYWORDS - If you restore the default keywords in version 1.5, it will use 
MK's keyword file.  In most cases, new users would want to start with a set of 
keywords already established for the common included files.  MK's keywords 
include a lot of purchased patterns that many will not have, but may come across 
later. 

• SYNC KEYWORDS - A new way to keep two device's keywords in sync. 

• RESET DESIGNS FOLDER - A utility to help start with the default patterns without 
losing anything. 

Fixes / Enhancements: 

• LONG PATH ERROR HANDLING - Many Windows features do not deal with files that 
are located in a folder path that exceeds 260 characters.  QPI will no longer display 
an error message and will index and display these files.  However, some features will 
not work until you manually shorten the path. 

BAD EXAMPLE:   C:\DESIGNS\#Purchased_Patterns\My favorite designer\really 
nice borders\curley and fluffy borders\bought in February\on the 23rd\while 
wearing short pants\saved as format QPI\My favorite designer\really nice 
borders\curley and fluffy borders\bought in February\on the 23rd\while wearing 
short pants\saved as format QPI\border1.qli 

GOOD EXAMPLE: C:\DESIGNS\#Purchased_Patterns\Mdesigner\boarders\curley-
fluffy\February\23rd\QPI\border1.qli 

• Config files in the user's hidden APPDATA folder are automatically backed up and if 
there is a corruption, restored to the previous version.  - File corruption was a very 
rare occurrence, but it is best to be safe. 

• Auto-deletion of "_.*" files in the managed folders.  These files are brought over from 
the MAC file system and are not needed.  They would show up as broken/corrupt 
patterns in QPI. 

• Red X icons change to a broken file icon.  Viewing these files in File Explorer - use 
the new context menu option - often will show that they are not valid pattern files.  
You can choose to just delete these files from the context menu. 

Example:  The "C:\Designs\1-PS Designs\Corners\Flower Pots Corners.hqv" being 
distributed with the PSP Beta is a zero byte file.  No pattern information. 
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